INTRACEREBRAL HEMATOMA
VOLUME MEASUREMENT FROM CT
Using Analyze
# Table of Contents

1. Introduction *page 3*

2. Semiautomatic Segmentation of Hematoma *page 6*

3. Manual Segmentation of Hematoma *page 16*
   - I. Trace Tool *page 17*
   - II. Draw Tool *page 18*
   - III. Spline Edit Tool *page 19*

4. Measurement of Hematoma Volume *page 21*

5. References *page 24*
Introduction

This guide will focus on quantifying the volume of hematomas due to intracerebral hemorrhage (ICH), which accounts for about 15% of strokes\(^1\). Hemorrhagic strokes tend to be more severe than ischemic strokes (which are 10 times as common)\(^2\). Hemorrhagic strokes are associated with a higher risk of death than ischemic strokes of the same severity\(^2\).

Intracranial hemorrhages are divided into intracerebral and extracerebral hemorrhages based on anatomical location of the hematoma. Extracerebral hemorrhages can be subdivided into epidural, subdural, subarachnoid, and intraventricular hemorrhages\(^1\).
The most prevalent cause of spontaneous ICH is hypertension, which is responsible for about 65% of cases\textsuperscript{3}. Other causes include cerebral amyloid angiopathy, brain tumors, aneurysms, arteriovenous malformations (AVMs), cerebral cavernous malformations, arteriovenous fistulae, sympathomimetic drug effect, and the use of anticoagulants and thrombolytic agents\textsuperscript{1,3}.

Epidural and subdural hemorrhage are usually caused by head trauma, while subarachnoid and intraventricular hemorrhage are sometimes caused by trauma and sometimes occur spontaneously from aneurysm rupture, arteriovenous malformation, or as an extension of an ICH\textsuperscript{1}.

The consequences of ICH are divided into primary and secondary injuries. Primary injuries are due to the initial bleed and hematoma itself, while secondary injuries occur as a result of the body’s reaction to the clot.

Primary injuries are caused by increased intracranial pressure from the hemorrhage, which can lead to compression of parts of the brain, changes in blood flow and perfusion patterns, and possible brain herniation\textsuperscript{3}.

Secondary injuries include inflammation, toxic byproducts of clot breakdown (e.g. iron), and perihematomal edema (PHE)\textsuperscript{3}. PHE appears on CT images as a hypodense region surrounding the hemorrhage and can be segmented using edge detection\textsuperscript{4}. PHE formation is a result of differing mechanisms over time, beginning with hydrostatic pressure effects and clot retraction in the first few hours after hemorrhage, then coagulation and thrombin production in the first two days, and lastly erythrocyte lysis and hemoglobin toxicity\textsuperscript{5}. 

![Image](image.png)
Computed tomography (CT) is more often used to evaluate ICH because it is faster than magnetic resonance (MR) and therefore preferable in unstable patients\(^4\).

Changes in CT attenuation values of an intracranial hemorrhage over time can be attributed to changing densities of protein molecules (mostly hemoglobin). For example, aggregated red blood cells or fibrin networks exhibit relatively high intensity in CT and can be visualized as an area of hyperintensity, whereas plasma or edema exhibit lower intensity in CT and may appear as an area of hypointensity\(^1\).

In a clinical setting, hemorrhage volume can quickly be estimated using the ABC/2 method, which approximates the hemorrhage as an ellipsoid\(^6,7\). Computer-assisted volume measurements, such as the method shown here, are preferred for research due to their higher accuracy. In addition, the ABC/2 method may provide inaccurate volume estimations in situations where the hematoma does not have an ellipsoid shape, such as in warfarin-related intracranial hemorrhage\(^6\).

This guide will show the semi-automated and manual methods available in Analyze for intracerebral hemorrhage segmentation from CT data. These methods may also be applicable for other types of intracranial hemorrhage. Finally, this guide will demonstrate how to make a volume measurement of the segmented hematoma using Analyze.
Semiautomatic Segmentation of Hematoma

Load an ICH CT data set into Analyze. The sample data set is available for download from http://analyzedirect.com/data/. With the data set selected in the Analyze workspace, open the Volume Edit module (Segment > Volume Edit). Initially it may be difficult to visualize the hematoma. In order to make the hematoma easier to see, open the Intensity Images window (View > Intensities). Change the Type to Window, and select the Level/Width radio button. Try setting the Level to 40 and the Width to 80.
First, we will segment the skull using a semiautomatic method. This method will first isolate the voxels that represent the skull into a separate object that will allow for easier segmentation of the hematoma. Voxels classified as skull can be locked and used as a limit when segmenting the hematoma. Navigate to the Semi-Automatic tab on the left side of the Volume Edit window and select the **Region Grow** radio button. Click on the skull in one of the orthogonal images in order to set a seed point.
Adjust the threshold range using the Threshold slider. The minimum threshold value should be around 100, and the maximum should be set to the highest possible value. Click the Extract Object button to extract the skull.

The skull object can now be locked to create a boundary for the hematoma object. To lock the skull object, click the padlock symbol to the left of the object. Rename the object to skull.
Now the hematoma can be segmented. There are a few possible methods of segmentation, ranging from manual to semi-automatic. For ICH datasets which have a well-defined hematoma, the semi-automatic object extractor algorithm may be used. This involves setting a seed point in the hematoma, defining a threshold range, and extracting the hematoma with a single click. The auto_TRACE method is slower than the object extractor method, but it is relatively fast and may be more accurate for less well-defined hematomas. The auto_TRACE algorithm relies on voxel intensities, which may not perfectly define the hematoma if there are regions which are isodense to brain parenchyma. Manual methods, which are outlined in the next section of this guide, may be the most accurate in defining hematomas with irregular grayscale intensities, but they are also the most dependent on the user and may be less repeatable.

The auto_TRACE method of segmentation takes advantage of the locked skull object. To use this method, navigate to the Manual tab and select the Auto Trace button. Click the Add Object button to add a new object and name the object Hematoma.
This data set was acquired axially, so we will define the hematoma on axial slices. The auto-trace algorithm requires a seed point and threshold range to define the object on a given slice. These parameters can be carried forward to the next slice or back to the previous slice once the segmentation is applied on the current slice. Select a seed point in the hematoma and choose a threshold range that defines the hematoma. For this data set, the threshold range chosen was 38 to 70. If the dotted line spills over into another region, it may be necessary to draw a limit.
To draw a limit, select the **Draw Limit** radio button and trace lines on the axial image to bound the hematoma region.
Set **Auto Advance** to **Forward**, and then click the **Apply** button to apply the segmentation to this slice. The same seed point, threshold range, and limits will be applied to the next slice. If they correctly define the region, click Apply again (or press the A key on the keyboard). If the seed point or limits need to be redefined, click either the Reset Seeds or Reset Limits button, then redefine these parameters. Continue to move through the data set until the hematoma is defined on all axial slices on which it appears.

The intracranial space can easily be segmented by locking the skull and hematoma objects and using the Object Extractor tool under the Semi-Automatic tab. Click the **Add Object** button to add a new object and name it Intracranial Space.
Click in the intracranial space to set a seed point and adjust the threshold range so that the intracranial space is roughly defined by the binary mask.
Click the Extract Object button to extract the intracranial space.
The colors of the objects can be changed by clicking in the Color box and typing a color name or clicking the palette icon. The rendering in the top right of the Volume Edit window can be made transparent by right-clicking in the rendering window and selecting Transparency. This allows the hematoma to be viewed in the context of the skull. Save the finished object map (File > Save Object Map).
Manual Segmentation of Hematoma

There are a number of manual options available for segmenting the hematoma. To view these options, navigate to the Manual tab. To use any manual segmentation tool to segment the hematoma, first click the Add Object button and name the new object Hematoma. After using a manual tool to define the hematoma on a given slice, navigate through the slices using either the scroll wheel of the mouse, the slide slider, or by setting Auto Advance to Forward or Backward. After defining the hematoma using one of the following manual methods, be sure to save the object map (File > Save Object Map).
Trace Tool

This tool is used by drawing a closed contour around the hematoma on an axial slice. The contour will automatically be filled on that slice.

Draw on any of image to define a region. Draw on the rendering to define a 3-D region along the viewing path. The currently selected object determines the new region's object.
**Draw Tool**

This tool involves filling the region using an adjustable-size circle, square, or diamond pen cursor and can be easier to implement than the Trace tool.

*Draw on any of the images to define a region. Draw on the rendering to define a 3-D region along the viewing path. The currently selected object determines the new region's object.*

- **Pen Shape:** circle, square, diamond
- **Pen Size:** 10
- **Current Pen:** red

**Auto Advance:** Off, Forward, Backward

**Buttons:** Reset Seeds, Reset Limits, Redo, Undo
Spline Edit Tool

The spline tool can be very effective when implemented using the Auto Advance option. After the initial spline is defined, press the A key on the keyboard to apply.

Create a New Spline Region or Convert a current region into a Spline. When creating a new spline region, double click when finished. Use the middle mouse button to adjust control points. Use the left mouse button to add new control points. Use the Delete to delete control points. When complete, click Apply to convert the spline back to an object region.
The spline points will be carried to the next slice if Auto Advance is set to Forward (or the previous slice if it is set to Backward). The control points that no longer correctly define the hematoma on the new slice can be moved using the middle mouse button, and the others can be left alone. A further option is to enable Smart Edge, which uses edge detection algorithms to guide the spline. The sensitivity of the smart edge can be adjusted using the Sensitivity slider bar when Smart Edge is enabled. In this way the hematoma can quickly and accurately be defined on all axial slices where it appears.

Perihematomal edema can be segmented by locking the hematoma and skull objects and tracing the hypointense edema region manually on each axial slice. Another option would be to lock the skull and trace the region containing both hematoma and edema. This combined object could then be separated into its components by locking all other objects and applying a threshold to define the edema as a new object, leaving the hematoma. A recommended threshold range for defining PHE is 5 to 23 Hounsfield units. Using a threshold rather than simply a manual trace method gives more uniform results.
Measurement of Hematoma Volume

Select the data set in the Analyze workspace and open the Region of Interest module (Measure > Region of Interest). Load the object map created in the segmentation step (File > Load Object Map).

In the Sample Options window, set the following parameters:

- Set Sample Type to Object(s)
- Select the Hematoma object
- Set Summing to On
- Sample to All Slices
- Sequence Display to Off
- Log Stats to On

Choose a number of decimal places and specify in the Decimal Places box.
Click the **Configure Log Stats** button and deselect the Area checkbox. Click Done to close the ROI Stats window.
In the Sample Options window, click the **Sample Images** button to measure the volume of the hematoma. The ROI Stat Log window will open and show the measured values. Save this data as a .stats file by clicking the Save button or right-clicking in the window and clicking Save Log or Save Log As.
References


Learn more about Analyze
Visualization and Analysis Software for Medical Imaging

FREE TRIAL
Get Started Now